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ABSTRACT
 

Bollinger, Michael A., Validating Side Scan Sonar as a Fish Survey Tool.  Master of Science 

(MS), December, 2015, 65 pp., 4 tables, 14 Figures, references, 104 titles. 

Hydroacoustic methods can be used to answer a variety of questions regarding fish 

populations and behavior. In this study, side scan sonar methodology was developed to quantify 

abundance and biomass and compared to established visual observation methods on SCUBA 

over artificial reef structures in the western Gulf of Mexico. Side scan sonar methods were 

equivalent to SCUBA surveys for measuring fish abundance over the same reef areas, however, 

abundances were significantly higher when the larger area sampled by side scan was utilized. 

Side scan sonar methods were also more time efficient than SCUBA, ROV and long line fishing 

methods (66.7%, 33.3%, 25.9% respectively). In addition, side scan methods allowed biomass 

and fish size class categories to be estimated over reef sites. Side scan methods allowed five reef 

sites to be surveyed in one day, demonstrating the capability for macro scale comparisons of fish 

abundance, biomass and behavior among sites. 
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CHAPTER I 
 
 

INTRODUCTION

 
 
Hydroacoustic methods can be used to answer a variety of questions in aquatic 

environments (i.e. population surveys[1], long term ecological monitoring [2], behavioral 

surveys[3,4], etc). These methods can be used in areas that are largely inaccessible to visual 

census. Hydroacoustic methods, such as sonar, are becoming more prevalent as the cost of 

equipment decreases. Compared with early versions with printed echograms on paper, even 

present day consumer grade instruments are far more sophisticated. Modern day sonar equipment 

is being used to answer difficult questions that would otherwise be outside of the capabilities of 

human monitoring. These methods have been used to capture long continuous time series [2,5] or 

cover large areas of seafloor [6]. The large coverage area capability of hydroacoustic methods 

can be used to assess reef function in terms of fish use of habitat both spatially and temporally, 

metrics that have been a constant challenge to researchers in the past 

 Artificial reefs serve important functions as habitat to fishes all over the world [7]. They 

attract biofouling organisms such as algae, sponges and other encrusting invertebrates that 

provide additional structural complexity and serve as recruitment substrate [8,9]. While these 

reefs are generally found to increase productivity in areas that they are placed [10,11] questions 

remain regarding their costs and benefits and what structures provide the best outcomes over the 
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long-term. More assessment tools are needed to determine the types of structures and materials 

that are most beneficial as artificial reefs. 

Reef Monitoring and Census Techniques 

Reef monitoring is conducted for numerous reasons, such as determining the state of a 

fishery [12], the effectiveness of the reef [13], and fish behavior to better manage a fishery 

[14,15]. There are over 4,000 artificial reefs in the Gulf of Mexico, composed of numerous 

structural types, which are challenging to asses and monitor efficiently. Currently, the Texas 

Parks and Wildlife Department (TPWD) Artificial Reef Program (TARP) monitors 73 areas 

along the Texas Coast. These reefing areas typically contain multiple structures, and many 

additional reef deployments are planned in the future[16]. Monitoring the fish populations of 

these artificial reefs is an important component to both the National Artificial Reef Plan (NARP) 

[17] and Texas Artificial Reef Plan [16].  

Current monitoring protocols for artificial reefs include: vertical long line fishing for size 

metrics of red snapper (Lutjanus campechanus, Poey, 1860), remotely operated vehicle (ROV) 

surveys, stationary hydroacoustic surveys and visual SCUBA surveys. While SCUBA surveys 

remain the most popular survey method to quantify fish abundance and biomass, they can only 

be performed under limited conditions [18]. ROVs can be used to survey reefs, especially when 

they are at depths inaccessible to SCUBA divers [15,19–21]. Visual census techniques are only 

useful in the range of 10s of meters in the clearest waters. In addition, the presence of a 

nepheloid layer (stratified layers of suspended sediments [22]) in the western Gulf makes visual 

surveys challenging for parts of the year [22,23]. In addition, these visual surveys provide little 

information regarding how reefs differ on scales larger than a diver can see or at multiple time 

points during a day. It is clear that management agencies need additional tools to cover larger 
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reefing areas with a wide variety of structural types [24]. While visual monitoring is still a major 

component of monitoring artificial reef deployments [16,25,26], advanced hydroacoustic 

methods show great potential [27–30].   

Artificial Reef Fish Populations 

In terms of biomass, many of the fish species commonly surveyed occur in the water 

column. According to quarterly visual SCUBA surveys over artificial reefs in 2014, some 

common species that occur in the water column were: Atlantic spadefish (Chaetodipterus faber, 

Broussonet 1782), blue runner (Caranx crysos, Mitchill 1815), lookdown (Selene vomer, 

Linnaeus 1758), grey triggerfish (Balistes capriscus, Gmelin 1789), sheepshead (Archosargus 

probatocephalus, Walbaum 1792), and the vermillion snapper (Rhomboplites aurorubens, 

Cuvier 1829).  Recreationally and commercially targeted species such as red snapper (L. 

campechanus), grey snapper (Lutjanus griseus, Linnaeus 1758), cobia (Rachycentron canadum, 

Linnaeus 1776), and greater amberjack (Seriola dumerili, Risso 1810) are also commonly 

observed [19]. 

Recreational saltwater fisherman brought over $2 billion to the state of Texas in 2011 

alone [31]. The majority of these economically important fishes reside in the water column - an 

aspect that lends itself to the use of acoustic monitoring techniques [28]. Red snapper (L. 

campechanus) is one of the most important recreationally and commercially harvested fish 

species [31,32] that inhabits depths from 10 m on nearshore reefs to 190 m on the shelf edge in 

the Gulf of Mexico [33,34]. They occur in large numbers in the water column over reefs and are 

important reef predators [35].  

Commonly targeted fishes are regulated by size. Size classes are generally determined 

based on predicted ecological niches [5] or legal catch limits of economically important fishes 
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[36]. Categorizing reef fishes by size is a common practice used to examine the state of a fishery 

[36]. Knowing what genera or life stage a fish belongs to, can often help to place it in a 

predetermined size category. For instance, juvenile forms of all common reef fishes can be found 

over artificial reefs in a < 30 cm size class. Fishes comprising a 30-60 cm size class consist of 

red snapper, grey snapper, young amberjack, Atlantic spadefish and sheepshead. Fish species 

comprising a 60-90 cm size class are larger individuals of red snapper, grey snapper and 

amberjack. Fishes that grow larger than 90 cm are usually greater amberjack, cobia, great 

barracuda, African pompano (Alectis ciliaris, Bloch 1787) or large sharks (Scalloped 

Hammerhead, Sphyrna lewini, Griffith and Smith 1834; Bull Shark, Carcharhinus leucas, Müller 

and Henle 1839).  

While it is known that large fish populations exist on artificial reefs, it is unclear what 

factors drive differences between reef configurations. Studies have documented fish preference 

for different sides of a particular reef [37] and preference for different reef configurations of the 

same structural type [18].  Hydroacoustic methods help to examine these factors more closely, 

moreover, biomass estimation of these important recreational and commercial fisheries are 

possible. 

Fisheries Acoustics 

Sonar instruments that send and receive sound waves can be used to detect fishes or 

objects far beyond the range of human vision and within nepheloid layers [28]. Typically, two 

types of data are collected from acoustic returns: time between transmission and reception, and 

strength of echo return. The time factor shows how far a target is away from the sound source 

and strength of echo return, reported as echo intensity in decibels (dB) (logarithmic ratio of an 
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observed to a reference intensity level) [38], can be used to show a variety of biological 

parameters including fish lengths [36] and community biomass estimation [39]. 

 The wavelength (λ) of each frequency is related to the sound speed (c) and frequency (f) 

by λ = c/f. For each frequency, the proportion of energy reflected depends on the ratio of the λ to 

the size of the target [40] which is important for studies focusing on identifying microorganisms 

such as zooplankton [2,5,41]. For larger targets, such as fish, increased frequency enhances 

resolution. Fisheries acoustics generally use frequencies in the range of 10 kHz and higher [28]. 

The frequency chosen for a study depends on the availability of transducers and the 

environmental constraints of the study site. Shallow study sites (<20 m) allow for higher 

frequencies (>400 kHz) which generally yields higher resolution because there is smaller volume 

of water to attenuate the sound [40]. Conversely, deeper study sites require lower frequencies 

(10-200 kHz) to cover the entirety of the water column because higher frequencies would be 

absorbed before reaching the bottom [40], albeit with decreased resolution. 

Organisms return sounds differently depending on shape, size, and body composition 

[41,42]. In fishes, it has long been recognized that the swim bladder is one  cause of acoustic 

backscatter [43]. McCartney and Stubbs [44] found that backscattering cross section resolution 

of fish swim bladders increased with increasing frequency. However, fish with reduced swim 

bladder size, such as mackerel (Scombridae) or herring (Clupeidae), have an optimum frequency 

to yield the highest intensity [45,46]. Frequency is one way to determine acoustic fish 

classification [42] and target strength intensity (dB) is another [47]. Higher frequencies above 

~300 kHz reveal more about the body of the fish rather than just the swimbladder. In fishes, 

target strength (TS) is linearly related to standard length [48], so more detailed fisheries 

information can be analyzed by incorporating TS.  
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Target Strength and Transmission Loss 

Transmission strength loss from sonar can be attributed to spreading and attenuation. 

Spreading is defined as a geometric effect representing the regular weakening of a sound signal 

as it spreads outward from the source [40]. As the distance the sound has traveled increases, the 

area ensonified increases fourfold and the intensity decreases fourfold [49]. Attenuation, on the 

other hand, is the gradual loss of intensity (dB) as the sound progresses through the medium. In 

this case, sound intensity is lost as the wave progresses through the water. Attenuation is a 

function of viscosity, density, sound velocity and frequency [40]. In a shallow, well-mixed sea 

the only controllable variable is frequency, whereas frequency increases, absorption also 

increases. Spreading and attenuation become important factors and must be corrected for in post 

processing [50]. In many cases corrections for attenuation and spreading are done using beam 

angle and distance from the transducer [50]. 

Fisheries Acoustics Techniques 

Acoustic techniques are becoming increasingly sophisticated and useful in a variety of 

fisheries applications. They can be used to sample large volumes of water in a short time to count 

acoustic echoes from fish at any depth in the water column, except right next to the seafloor and 

at the surface [28]. 

Benthic fish, such as flounder (Pleuronectidae), are indistinguishable in acoustic surveys 

because they are obstructed by the stronger acoustic responses of the seabed [28,38,51]. Fish that 

tend to aggregate over structure, rather than remaining directly on it, like snapper (Lutjanidae), 

jacks (Carangidae) and grouper (Epinephilininae), make appropriate targets for acoustic methods. 

Abundance estimation for fish was developed in the 1950’s by Tungate [52] based on the 

idea of simply counting individual echoes [39,51–53]. In the early 1960’s investigators 
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developed the technology to integrate echo amplitude [53]. This integration of intensities is a 

standard today that is incorporated into almost all commercial and consumer grade echosounders 

[28]. 

Sonar Instruments 

A variety of sonar configurations have been developed over the years for fisheries 

applications. A single beam echosounder is the most commonly used sonar for bottom sounding 

and commercial fish finders [28]. Dual beam and split beam are more specialized systems that 

can determine TS and return position directly from each echo [28]. Multi-beam sonar and sector 

scanner sonar can create radar like two-dimensional displays and can be constructed into 3D 

images [28,54,55]. These are widely used in creating bathymetric maps and mapping schools of 

fish such as herring [56]. Side scan sonar was a technology originally created to construct two-

dimensional images of the seabed [28,50,57], but has been shown to be highly adaptable to other 

applications. 

Side scan sonar was defined by Fish and Carr [58] as “an acoustic imaging device used to 

provide wide area, large scale pictures of the sea floor of a body of water.” Side scan sonar has 

been used since 1963 to search for ship wrecks, look at sea floor configuration for the oil 

industry, and mapping benthic habitats [27,58]. The wide angle of emitted sound (beam angle) of 

side scan sonar allows a greater volume of water to be sampled than would be possible with a 

vertical echosounder [3,4,59]. 

Side scan units produce high quality images and side scan sonar transducers can be either 

attached to the hull of a vessel or mounted on a towfish (torpedo-like object tethered to a boat 

intended to get a transducer closer to the bottom). These units take the sonar echo and TS to 

create an image and these can be processed into a mosaic by merging survey lines together to 
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form a single image of the study site [27]. Since only one frequency is used, a wider swath of 

water can be covered, but less information can be retrieved from each echo return. Several 

studies have used side scan for observing fish including migration of salmon (Salmonidade) and 

herring in Canadian channels [3,4,6,59], surveying sturgeon (Acipenseridae) in the rivers of 

North Carolina [1,60] and counting and mapping pelagic fish schools [61]. While size 

classifications have occasionally been conducted with side scan sonar, no biomass estimates 

were noted. 

Estimating Biomass 

Some of the most important applications of fisheries acoustics are estimations of density, 

abundance, and biomass of fish [62]. An essential requirement of estimating biomass is the use 

of solid sphere calibration [63,64]. Two standard outputs of biomass estimation are volume 

backscatter strength (Sv) and TS. Volume backscatter is an integration of acoustic energy 

scattered from discrete targets per unit volume of water, and is often used as a proxy for fish 

biomass [28,62]. TS is an acoustic measurement of intensity from an individual target. Love’s 

[48] lateral TS equation is widely used to estimate fish length from TS [65–68]. Fish length is 

then converted to weight using known length to weight relationships for commonly sampled fish 

species within the survey area [39]. Due to the lack of information regarding species 

identification from individual sonar returns, biomass estimates are generalizations based on the 

fish community sampled. Thus, it is important to know the common species that will be 

encountered to correctly estimate biomass [39]. 

Objectives and Hypotheses 

The overall aim of this research was to validate side scan sonar as an additional reef 

survey tool. Side scan sonar units have proliferated in the marketplace from several 
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manufacturers with higher frequencies and convenient data recording methods. They have 

become popular for both recreational and commercial fishing applications and are a tool readily 

adapted to survey reef-associated fish [69]. A major goal of this study was to determine if side 

scan sonar methodology could adequately quantify fish abundance and biomass over a variety of 

reef structural types. To do this, fish abundance estimates using side scan sonar were compared 

with SCUBA surveys. The expanded coverage area of side scan sonar as compared to SCUBA 

was utilized to compare spatial and temporal differences in fish abundance and biomass while 

the costs and benefits of side scan sonar were compared to other common methodologies.  The 

following hypothesis tested the feasibility of the side scan sonar methodology to be used as a fish 

census tool: 

• Side scan sonar surveys will detect a higher fish abundance than SCUBA surveys within 

the same sites. 

To analyze reef structure and the behavior of fishes over artificial reefs, two additional 

hypotheses were tested: 

• Reef structural types will be significantly different in fish abundance and biomass as 

surveyed with side scan sonar.  

• Fish will exhibit a preference to a side of the structure throughout the day. 
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CHAPTER II 
 
 

METHODS

 
 

Study Sites 

This study was conducted in the western Gulf of Mexico [8,18,70–72] at five 

representative reef structural types (Figure 1). The surface area covered for each structure was 

calculated from side scan sonar images using structure length and width approximated as a 

rectangle. 

 

1) Culvert reef (PS-1047, N 26° 31.535’, W 97° 09.215’) is a nearshore TARP site of 1 

km2 area, 6.51 nm offshore of the Port Mansfield jetties, at a depth of 21 m and contains 

4,922 concrete drainage culverts that are approximately 3 m in length and varying reefing 

density [18]. Multiple sites (see results for details) within this reef were surveyed with a 

mean surface area of 300 m2. Reefed in 2011, the culvert reef represents an early 

successional community. 

 

2) 3-pile jacket reef (PS-1169L, N 26° 12.902, W 96° 58.945’) is a nearshore TARP site, 

located 7.11 nautical miles (nm) beyond the South Padre Island jetties at a depth of 24 m, 

containing two 3-pile oil rig jackets that are approximately 30 m long, 9 m tall. One of 

the 3-pile jackets has a small tugboat directly adjacent to it. The surface area of each 
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structure was 192 m2. Reefed in the 1994, the 3-pile jackets are some of the latest 

successional states of the artificial reefs surveyed. 

 

3) 4-pile jacket reef (PS-1070, N 26° 25.499’, W 97° 01.257’), is 15.38 nm offshore from 

the Port Mansfield jetties. The 4-pile oil rig jackets that are 30 m long, 12 m tall and lie at 

a depth of 31 m. The surface area of each structure was 240 m2. Reefed in the 1994, the 

4-pile jackets represent the latest successional states of the artificial reefs surveyed. 

 

4) Ship: The Texas Clipper Artificial Reef (PS-1122, N 26° 11.187’, W 96° 51.342’) lies 

17.23 nm from the South Padre Island jetties and is a single, 144 m long vessel that lies 

35 m depth. The surface area of this structure is 3,600 m2. Reefed in 2007, the ship 

represents a middle successional state community. 

 

*5) Natural reef (N 26° 26.127’, W 97° 0.613’), Big Sea Bree reef lies at a depth of 33 m 

and spans 6 km. Vertical relief in this area ranges as high as 4 m. The natural reef surface 

area was 300 m2 per scan. The natural reef area was assumed to be at a very late 

successional or climax community. *The natural reef site was used only in the rapid 

assessment. 
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Figure 1.  Side scan images of the five structural types sampled in this study. A) South Padre Island Reef, concrete 
culverts.  B) Port Isabel Reef, 3-pile jacket.  C) Port Mansfield Liberty Ship Reef, 4-pile jacket.  D)  Texas Clipper 
Reef, ship. E) Big Sea Bree, natural reef. 
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Sonar Equipment 

A Humminbird 1198c SI Combo (Johnson Outdoors Marine Electronics, Inc., Eufaula, 

AL, USA) (Figure 2) was used in this study. The Humminbird has vertical beams operating at 83 

kHz (60° @ -10 dB re 1 µPa) and 200 kHz (20° @ -10 dB re 1 µPa) and horizontal beams 455 

kHz (86° @ -10 dB re 1 µPa; total 180° of overall coverage) and 800 kHz (55° @ -10 dB re 1 

µPa; total 130° of overall coverage). The transducer (part # XPTH 14 74 HDSI T, Johnson 

Outdoors Marine Electronics, Inc.) was mounted in a towfish (“The Tank” part # FRO-HST, 

First Response Outfitters, Willis, TX, USA). The sonar equipment was further modified with 

waterproof connections and the transducer cable was extended (Appendix A). 

 

Figure 2.  Humminbird 1198c head unit and towfish used in this study 

Range Verification 

The sampling volume suggested by the manufacturer was verified using two sonar 

reflective Ecobuoys (Ecobouy Pty. Ltd, Malvern, Victoria, Australia) placed on a vertical line 5 

m from each other and 5 m above a cement block anchor. Two identical lines were attached 5 

and 10 m from the original buoy line. An additional surface marker buoy was attached at the end 

of the array to retrieve the buoy array and make navigation easier for the captain (Figure 3). 

Transects were run perpendicular to the location of the buoy array. The combined angle of the 

beams was verified as semicircular and measured 180°. 
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Figure 3.  Schematic of the range verification experiment.  Each submerged buoy was 5 m from each other and the 
surface marker buoy was marked with a GPS waypoint to make navigation easier. 

Sonar Target Strength Calibration 

Target strength (TS) of the sonar was calibrated by using solid, non-resonant, tungsten 

spheres of sizes 22.225 mm, 20.0 mm, 19.05 mm, 15.0 mm and 12.7 mm and a frequency of 455 

kHz [63,64,73–75]. The theoretical target strength for each of the different size spheres was 

calculated [75], as shown in Figure 4. Equation 1 was used to calculate the backscattering cross 

section (σBS) of the sphere where it is related to the angular frequency (ω) in radians, the radius 

of the sphere (a), the sound speed in the water (c), the density of the water (ρ), the density of the 

sphere (ρ1), the longitudinal wave sound speed of the sphere (c1) and the transverse wave sound 

speed of the sphere (c2). 

σBS = (a2/4)F(ωa/c, ρ1/ρ, c1/c, c2/c) (1) 

 

The predicted target strength of each sphere was calculated with Equation 2 [28].  
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 TS= 10Log10(σBS) (2) 

 

The spheres were suspended in monofilament sacks attached to a 45 kg test 

monofilament line. Targets were passed on both the left and the right side of the transducer at 

distances of 5 m and 10 m. 

Solid sphere calibration of the side scan sonar at 455 kHz yielded equation 3, where TS is 

on the y-axis and grey scale value (GSV) is on the x-axis. This equation relating GSV to TS 

intensity was applied to images during calibration in ImageJ. 

 

 TS= 0.37265(GSV) – 80.02 (3) 

 

Figure 4.  Theoretical target strengths for tungsten calibration spheres for 455 kHz sonars.  Sharp downward peaks 
represent resonance within the solid sphere. 
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Sonar Surveys 

Sonar surveys consisted of three consecutive, equal length passes over each reef structure 

or section of reef. After processing, only the pass with the highest abundance from each structure 

was used in analysis. Vessel speed was kept below 5 knots to ensure towfish was flown 

approximately 6 m below the surface to avoid the effects of propwash and influence of the sea 

surface.  

SCUBA Surveys 

SCUBA surveys consisted of a 15 minute modified roving diver survey [18] in which 

divers counted all individual fishes in the water column over the reef structure. Water column 

visibility (m) was recorded by divers and tested as a covariate against both sonar and SCUBA 

data. 

Post Processing 

Abundance 

Images were generated with the PyHum program (v1.3.3, US Geological Survey, 

Flagstaff, AZ, USA [76]) written in Python (v 3.4.3, Python Software Foundation, Beaverton, 

OR, USA [77]). PyHum was adapted to generate water column clips from side scan sonar data 

(Appendix B). 

Preliminary analysis of raw sonar scans revealed significant amounts of attenuation as 

fish target distance from the transducer increased. To correct for attenuation, a cosine-range 

correction was applied to the data (PyHum). Calibrated images were edited manually in 

Photoshop to remove bottom structure and water column interference. These images were used 

to calculate abundance and biomass (see next section). The processed images were opened in 
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ImageJ (v.1.48p, National Institutes of Health, Bethesda, MD, USA) and intensities were 

calibrated. Fish targets were counted and intensities recorded (Figure 5). Best fit Image J setting 

combinations as compared to manual counting results and image processing macro detailed in 

Appendices A and C, respectively.  

A minimum fish TS threshold of -60 dB was determined in ImageJ and particles larger 

than 20 pixels and 0.05 circularity were counted. In a linear regression [78] of automated counts 

of fishes conducted in ImageJ vs. manual Photoshop counts, a slight underestimation of 

automated ImageJ counts was noted and a correction equation was applied to all sonar count data 

(y = 1.1417x; r2 = 0.864; p<0.001; Figure 6). 

Fish abundances were scaled to area of each reef structure as fish density (DF) to make 

abundances more comparable among reef structure types (Equation 4). 

 

 DF = Total number of fish/ Reef area  (4) 
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Figure 5.  Manual fish counts in Photoshop compared to automated ImageJ.  Linear correlation and regression were 
significant (R2=0.864, y=1.1417x, p<0.001).  Regression equation was applied as a correction factor to the data in 
this study. 

 

Figure 6.  Example of a cleaned up image with a threshold applied in ImageJ.  Fish counted manually = 340.  
Automated fish count = 305 * 1.1417 (correction factor) = 348. 
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Biomass Estimation 

As detailed above, each grayscale image with the interference, seabed and reef structures 

removed in Photoshop was used to calculate fish TS in ImageJ. Each image was imported into 

ImageJ where the image was calibrated using Equation 3. Post calibration, ImageJ was used to 

calculate max individual TS from all targets in the image using a threshold of -60 dB, particles 

larger than 20 pixels, and 0.05 circularity. Fish standard length (Lcm) was calculated for all 

individuals using Equation 5 [48] and a mean standard length (cm) was determined. 

 

 TS = 24.1 * log10(Lcm) - 61 (5) 

 

After mean standard length was determined, a mean weight (g) was calculated using 

published length-to-weight relationships of commonly sampled fish species occurring over reefs 

in the Gulf of Mexico (see Table 1). A fish community length (L)-weight (W) relationship (Table 

1, Figure 7 Equation 6) was calculated by averaging log-transformed data to form individual 

species growth curves. 

 

 W = 0.0232* L2.9088 (6) 

 

Biomass (g/m3) over the reefs was calculated in Equation 7 by multiplying fish density 

(DF) by mean fish community weight. 

 

 Biomass= W * DF (7) 
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Table 1.  Parameters used in calculating the mean weight to length ratio for gulf fishes, where Weight = a*(Length)b.  
All functions were recalculated so length was in cm and weight was in g. 

Species Max L 
(cm) a b Source 

Selene vomer  48 0.018 3.013 [79] 
Lutjanus griseus  89 0.0156 2.93 [80,81] 

Caranx crysos  70 0.0306 2.861  [82] 

Lutjanus campechanus  100 0.01346 3.05 [83] 

Balistes capriscus  60 0.03610 2.78 [81,84] 

Chaetodipterus faber  91 0.03921 2.938 [85] 

Archosargus 
probatocephalus  91 0.03415 2.89 [81,86] 

Seriola dumerili  190 0.01739 2.86 [87] 
Rhomboplites aurorubens  60 0.01346 3.0106 [85] 

 

 

Figure 7.  Weight-length ratios for common mid-water column fishes (9 total) in the Western Gulf of Mexico.  The 
average of the ratios were calculated and plotted in bold. 
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Methodology Comparison 

Paired side scan sonar and SCUBA counts were conducted opportunistically from May 

2014 and June 2015. Visibility was noted qualitatively by divers as water column visibility 

(WCV) on SCUBA surveys. Water column visibility was not a significant covariate in the 

multivariate analysis of variance (ANOVA) comparing SCUBA and full transect sonar surveys 

(Sonar, F = 0.050, df = 35, p = 0.824; SCUBA, F = 2.127, df = 35, p = 0.155), therefore, paired t-

tests were used in further comparisons. SCUBA abundance was compared to sonar abundance 

limited to the area over the structure that a diver surveyed, using a paired t-test. In addition, 

SCUBA abundance was compared to sonar abundance utilizing the entire transect length, with a 

paired t-test. All analyses were done in SPSS (v. 21 IBM Statistics, Armonk, NY, USA) unless 

otherwise stated. 

Reef Structure Comparisons 

Abundance and biomass calculated from sonar returns and scaled to each reef area was 

used to compare reef structures using ANOVAs with a Scheffe post hoc tests. All data was 

verified for normality using Q-Q plot analysis and homoscedasticity using Levine’s test [78] in 

SPSS.  

Rapid Reef Assessment 

All reef comparisons were accomplished with the side scan sonar methodology detailed above. 

In the first comparison, four artificial reef locations and the natural reef were sampled in the 

same day. Three distinct sites were sampled at each location, with the exception of the ship 

where only one structure exists at the location. Three passes of 200 m were taken at each site 

where only the pass with the highest abundance was used in analysis. The reefs were compared 

by abundance and biomass using a multivariate ANOVA with a Scheffe post-hoc test and 
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verified for normality using Q-Q plot analysis and homoscedasticity using Levine’s test [78] in 

SPSS (v. 21). Fish size classes were calculated using individual TS, determined in image J, and 

the Love 1969 equation. In addition, fish lengths were binned into 30 cm classes (<30cm, 30-

59cm, 60-90cm, >90cm, Figure 8) as a comparison of size classes present at each reef type. Size 

classes were calculated as a percentage of the total fish abundance and analyzed with a Bray-

Curtis similarity, multidimensional scaling plot and cluster analysis in PRIMER-E v6 package 

[88]. 

Temporal Comparison 

Since preliminary surveys showed high abundances associated with 4-pile jacket 

structures at PS-1070, a temporal comparison was conducted to test the hypothesis that fishes 

exhibit a preference for a side of the structure throughout theday. Three passes of 200 m were 

taken at three 4-pile jacket structures during three time periods (10:00, 13:00, 18:00 hr) where 

only the pass from each structure and time period with the highest abundance was used in 

analysis. Each scan of an individual structure was divided into three sections based on cardinal 

direction and prevailing currents (Northwest, Southeast and over reef structure) in post 

processing. Repeated measures ANOVAs were used to examine abundance and biomass 

variation within each section of the structure with time of day and between sections of the 

structure with time of day. Fish size classes were also analyzed for this comparison using a 

multidimensional scaling plot and cluster analysis in PRIMER. 

Cost and Time Efficiency 

The side scan sonar methodology developed in this study to quantify reef associated fish 

was compared to SCUBA, remotely operated vehicle (ROV) and vertical long line fishing survey 

methods currently employed by TPWD. Effort in labor hours was estimated from ongoing 
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monitoring projects. The focus of this comparison was on time effectiveness and labor hours 

needed. 

The cost of the Humminbird setup used in this study was compared to commercial brands 

of similar functioning side scan sonar (Edgetech [http://www.edgetech.com], J.W. Fishers 

[http://www.jwfishers.com/sss.htm], C-Max [http://www.cmaxsonar.com], Tritech 

[http://www.tritech.co.uk]). Pricing information was gathered from each manufacturer’s website 

or quotes obtained from the company. 

 

Figure 8.  Example of side scan imagery with fish from each size class (small = <30cm, medium = 30-60cm, large = 
60-90cm and extra large = >90cm) and a mixed size assemblage (small - medium). 
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CHAPTER III 
 
 

RESULTS

 
 

Methodology Comparison 

Counts limited to directly over the structures by side scan sonar (326.52 ± 65.65 [mean ± 

SE]) were not significantly different than the paired SCUBA surveys (297.25 ± 50.09) (t = 0.259, 

df = 35, p = 0.797; Figure 9A). However, side scan sonar was able to cover a much larger 

volume of the water than just that which is immediately around the reef structure. When 

considering the entire sonar recording distance (239.6 ± 72.9 m),  sonar abundance (633 ± 

120.91) was significantly different than the SCUBA counts (t = -3.653, df = 35, p = 0.001; 

Figure 9B).  

Biomass per area reefed was significantly different among structure types (F = 5.788, df 

= 3, p = 0.003; Figure 10B). The 4-pile rig had significantly more biomass associated with it 

(3538.1 ± 947.7 g/m2) than the ship (76.5 ± 21.1 g/m2, p = 0.048), the culverts (453.0 ± 256.9 

g/m2, p = 0.006), with the 3-pile jacket being the exception (1442.9 ± 789.8 g/m2, p = 0.175).  
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Figure 9.  Sonar surveys A) limited to area over the structure (Structure Limited Scan) compared to scuba surveys of 
mid water column fish for each artificial reef structure ± SE (bars). B) normal length scans (Entire Scan) and 
compared to scuba surveys of mid water column fish for each artificial reef structure ± SE (bars).  A paired T-test 
for limited scan and scuba were not significantly different (t=0.259, df=35, p=0.797) while a paired t-test for the 
entire scan and scuba was significantly different (t=-3.653, df=35, p=0.001).  Further site specific paired T-tests 
show the 4-Pile rig is the only structure driving the significance.  Sample size included in parenthesis. 

  
Figure 10.  Abundance (A) and Biomass (B) estimates (±SE bars) per reefing area footprint for each of the artificial 
reef structures averaged over the study time. ANOVA (Abundance F = 14.752, df = 4, p < 0.001 ; Biomass F = 
7.200, df = 4, p < 0.001 ). Sample size included in parenthesis. 
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Rapid Reef Assessment 

An ANOVA and Scheffe post-hoc test revealed that the 4-pile jacket reef had 

significantly higher mean fish abundance per area reefed (4.603 ± 0.966, F = 14.752, df = 4, p < 

0.001) than the natural site (0.154 ± 1.762 fish/m2, p < 0.001), the 3-pile jackets (0.357 ± 0.406 

fish/m2, p < 0.001) and the culverts (0.180 ± 1.717 fish/m2, p < 0.001). Ship abundances were 

low but were not analyzed due to low sample size (0.050 ± 1.030 fish/m2) (Figure 11A). 

In addition, the 4-pile jacket reef had significantly more biomass (5329.0 ± 1531.0 g/m2
; 

F = 7.200, df = 4, p < 0.001) associated with it than the 3-pile jacket (4.3 ± 1.2 g/m2, p = 0.003), 

the culverts (137.5 ± 44.9 g/m2, p = 0.004) and the natural site (379.6 ± 350.2 g/m2 p = 0.007). 

The ship site observed low biomass but was not analyzed (26.0 ± 16.7 g/m2) (Figure 11B).		

 

Figure 11.  Abundance (A) and biomass (B) measures for each reef structure ± SE (bars) for the rapid reef 
assessment.  A) The 4-pile jacket structures (a) are significantly greater in abundance than the other structures 
besides the Ship (NR p=0.001, 3-P p=0.012, CC p=0.002, Ship p=0.334).  B) A similar trend is observed in biomass 
with higher biomass on the 4-pile rig than the other structures except for the ship (NR p=0.01, 3-P p=0.004, CC 
p=0.008, Ship p=0.075). 
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The fish assemblages by size class at concrete culvert, 4-pile jacket reefs and the ship 

exhibited 90% similarity to each other in the cluster analysis, while the natural reef was 80% 

similar. The 3-pile jacket reef was less than 60% similar to the other reef sites (Figure 12). The 

3-pile jacket reef fish assemblage was smaller than other structures comprised of 1% fishes 

larger than 30 cm while other structures had between 45-55% of the assemblage over 30 cm 

(percent greater than 30 cm: natural 55.2%, 4-pile 46.8%, culverts 45.1%, ship 43.4%; Figure 

12). 

 

Figure 12.  A) Fishes size class abundances for each reef structure scaled to 100 percent of the total abundance. B) 
Multidimensional scaling plot of fishes size classes at each reef location with 80 and 90% similarity groupings.  The 
4-Pile, Ship and Concrete Culverts are >90% similar to each other and the natural reef is within 80% similarity to 
the aforementioned three. 
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that was not significant regardless of position over the structure (F = 0.639, df = 2, p = 0.531; 

means: AM 0.758 ± 0.082, Noon 0.711 ± 0.105, PM 0.471 ± 0.043). 

A similar decreasing trend with time period was observed with biomass. Biomass over 

the structure decreased as the day progressed and biomass on the northwest side hit a minimum 

during the midday sampling, although not significantly (Repeated measures ANOVA within; 

over F = 3.280, df = 2, p = 0.073; NW F = 0.369, p = 0.699; SE F = 0.014, p = 0.979; Figure 

13B). No significant differences were observed within sections of the reef. Size classes showed 

high similarity (>80%) between the jacket structures and time of day (Figure 14). Each of the 

structures showed a drop in larger fish above 30 cm as the day progressed (Platform 1: AM 

39.0%, Noon 20.5%, PM 31.9%; Platform 2: AM 49.2%, Noon 39.0%, PM 19.6%; Platform 3: 

AM 43.6%, Noon 45.0%, PM 24.3%). 
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Figure 13.  Abundance (A) and biomass (B) estimates on the SE side, NW side and over the top of 4-pile jacket 
structures, at the Port Mansfield Liberty Ship Reef (PS-1070) ± SE (bars). The over structure abundance decreased 
during a daily sampling regime (Repeated Measures ANOVA, F=31.034, df=2, p=0.001) while biomass seemed to 
diminish during the midday samples (Repeated Measures ANOVA, F=6.500, df=2, p=0.012). Fishes abundance and 
biomass ahead and behind of the structure (with respect to currents) did not change significantly. 

 

Figure 14.  A) Fishes size class abundances for each platform (plat) structure and time scaled to 100 percent of the 
total abundance. B) Multidimensional scaling plot of fish size classes at each platform structure and time (Plat 
Number.Time) with 80 and 90% similarity groupings.  All structures and times are greater than 80% similar. 
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Cost Benefit Analysis 

The time effectiveness comparison showed that for surveys of four sites, using the 

methodologies defined in this study, side scan sonar used a total of 40 labor hours which 

included data collection and processing time (Table 2). Side scan sonar took approximately 

25.9% less time than vertical long line fishing, and 66.7% less time than SCUBA surveys to 

cover the same areas. 

The cost analysis showed that the Humminbird configuration in this study was 35.9% less 

expensive than the least expensive commercial unit (Table 3). The prices ranged from $7,800 to 

$40,000. In addition, all others required a user-supplied computer to record the data that was not 

in the estimates. 

 

Table 2. Time efficiency calculation for side scan sonar, remotely operated vehicle, long line fishing and scuba 
surveys as outlined by TPWD SOP and approximate time needed to complete surveys at Padre South Artificial Reef 
Sites.   Man Hours = Man Power ((4/ Sites per day)*(Travel Time) + (Time at Site * 4)) + Processing Time 

 

Man 
power 

Time at Site 
(hr) Sites/day Travel time/ 

day 
Total Field 

Time (4 sites) 
Processing 

time 
Labor 
Hours 

SS 2 0.5 4 6 8 24 40 
ROV 2 1 4 6 10 40 60 

Fishing 2 3 1 3.25 25 4 54 
Scuba 4 4 1 3.25 29 4 120 

 

Table 3. Cost effectiveness of the Humminbird system used in this study including all necessary software and 
modification hardware compared to published costs of other packages. 

System Used in this Study Other Packages 
Sonar $2,300 Edgetech $35,000 
Towfish $1,000 J.W.Fishers $25,000 
Hardware $600 C-Max $40,000 
Software $1,100 Tritech 990F $7,800 
Total $5,000 
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CHAPTER IV 
 
 

DISCUSSION

 
 

Abundance, biomass and size categories of reef fish were calculated with the use of a low 

cost and efficient method of processing side scan sonar data. To the author’s knowledge, this is 

the first study to use side scan sonar for the quantification of reef fish abundance and biomass. 

Abundance estimates of reef fish using the side scan sonar method proved to be comparable to 

SCUBA surveys, when restricted to the same coverage area, indicating its utility in reef surveys. 

Multiple studies ground truth their sonar surveys with trawl net tows [89] which would prove 

difficult on any reef structure. A main advantage of sonar is that it is not limited to the area 

directly over the structure in SCUBA surveys. The temporal comparison showed high fish 

abundance on end of the structure, possibly indicating a behavioral preference. Demonstrating 

that reef fish aggregations cannot be quantified using the SCUBA survey method in some cases. 

The sonar methodology quantified more fish than SCUBA when extending the survey 

into a larger water volume. A few studies have taken advantage of this large-scale water column 

sampling technique [6,90] and have been successful in enumerating fishes. Trevarrow [90] was 

able to count migrating salmon using a stationary side scan sonar but was unable to determine TS. 

Other studies have used a split beam or dual-beam echo sounder [28,89,91,92] but side scan’s 

fanlike beam pattern allow it to ensonify a larger water volume in a single pass [90]. One 

drawback of active acoustic methods and a reason SCUBA surveys cannot be completely 
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replaced by sonar, is a lack of clear species differentiation. Species identification is thought of as 

the “grand challenge of fisheries and plankton acoustics” [68] and some recent studies have 

shown promise [93–95]. 

Although species identification was not accomplished, the present study categorized reef 

fish into 30 cm increments for effective reef comparison. Jordan [96] showed a similar 

categorization of reef fishes in visual studies where fish lengths were broken down into five 

categories to look at small scale changes on artificial patch reefs. The present study was able to 

categorize fishes by length based on calibrated target strength, which is similar to other acoustic 

surveys where species identification has not been achieved [36,42]. Walline [36] was able to 

differentiate between three acoustically determined size classes of pelagic fish using Simrad 

single-beam sonar where their size classes were based on commercial catches. Similarly, the 

present study chose size classes that are based on the minimum recreational limits for commonly 

observed species. 

Habitat Comparisons 

In this study, the 4-pile jacket structures had significantly higher abundances surrounding 

them than any of the other structure types (Figure 11). Oil platform jacket structures have been 

reported to hold high abundance and diversity of fishes in other studies [19,97]. However, 

location may also play a role in the higher abundance observed. Garcia [71] suggested inshore 

sites, like the culvert reef, are fished more because of their location in state managed waters than 

offshore locations, like the ship, because of their location in federally managed waters. The 4-

pile structures were farther offshore and may have had reduced fishing pressure due to the lack 

of a surface marker buoy and extended closures of the U.S. federal fishing seasons for red 

snapper and amberjack. The 4-pile jackets have been reefed the longest and should represent the 
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latest successional community surveyed which could account for some of the high fish 

abundances observed. 

In the rapid assessment, the 3-pile jacket structures closer to shore had the lowest 

abundances despite their structural and reefing age similarities to the 4-pile jackets. Fishing 

pressure might have played a role in the differences observed at the 3-pile jacket structures due 

to their proximity to South Padre Island and the US-Mexican border. While fishing pressure and 

reef structure type are two obvious factors that may be associated with the observed differences 

in fishes, other parameters such as proximity to the coast, depth, currents as well as biological 

parameters (e.g., recruitment rates of biofouling which will support the trophic web, competition 

for resources, predation pressure) could account for variation in the differences observed and 

further studies are warranted. 

The size class differences observed at the 3-pile jacket in this study also support that 

fishing pressure may be the cause of the differences observed. The 3-pile jacket sites showed no 

fish above 60 cm during the reef comparison analysis, which may indicate predator depletion, 

likely from fishing [98]. Other sites showed a more even distribution of size classes especially 

above 60 cm and likely representative of predators. However, the biomass estimates for the 

overall method comparisons suggested a presence of higher numbers of fishes and larger 

individuals that were not observed in the single day reef comparison study. This may indicate a 

seasonal component and more reef comparison surveys are needed to draw further conclusions. 

The temporal comparison showed clear differences in fish abundances on different sides 

of the structures (Figure 13). Boswell et al. [24] showed fish abundance decreased as distance 

from the reef complex increased. Decreasing fish abundance with distance away from the 

structure was noted in most cases during the present study, fishes were consistently more 
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numerous on one end of the structure than the other. A potential reason for this side preference 

could be feeding patterns of the planktivorous species. Hamner et al. [37] found planktivorous 

fishes on the great barrier reef form a “wall of mouths” on the upstream, side of the reef where 

larger fishes would be farther from and smaller fishes would be closer to the reef. 

Fishes abundance at the structures tended to decrease as the day progressed (Figure 13). 

It is also well documented that fishes show diel feeding patterns [99,100]. This result shows the 

importance of timing any survey to be able to accurately sample the entire population. A feature 

easy to accomplish with side scan sonar but very difficult to accomplish with any visual methods. 

Boswell et al. [39] reported methodology for determining biomass in g/m3 of water 

volume sampled, and Boswell et al. [24] showed acoustic biomass in volume backscatter (Sv). 

This study scaled biomasses to reef surface area to account for reef size differences and make the 

structures comparable. Both are acceptable methods for reporting the statistic [28]. Boswell et al. 

[24], covered an entire artificial reef, but made no comparisons of other structures as conducted 

in this study. In the present study, fishes were assumed to be associated with the reef structure so 

these scaled results could be used to make inferences regarding each of the reef structures. 

Low Cost High Efficiency 

The cost-benefit analysis showed that side scan sonar is a low cost, high efficiency 

method for quantification of reef fish. The rapid assessment of reef structures with side scan 

sonar demonstrated in this study would allow managers to sample multiple sites in a single day 

which creates a large data set of comparable data. Large datasets are now manageable with the 

accessibility of large storage devices and faster processors [101,102]. The ability to collect large 

amounts of acoustic data over a numerous structural types can be advantageous because multiple 

questions can be answered from a single data set. 
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The use of the Hummingbird and SD memory card recording made the data acquisition 

convenient and economical. The present method used the programs HumViewer, PyHum and 

ImageJ, all freeware, coupled with Adobe Photoshop to create a semi-automated method to 

process the side scan sonar data. Many commercial sonar packages require expensive software 

and annual service agreements in addition to the purchase of the hardware. Boswell [103] 

outlined methodology to partially automate processing of dual-frequency identification sonar 

(DIDSON) data. Automating the data processing streamlined the method and cut down the labor 

needed to obtain results using this method. Freeware, such as PyHum, cuts down on the initial 

cost of starting a project and because it is based on an open source program, it can be highly 

adaptable. In another study, Buscombe [50] used a Humminbird sidescan sonar and PyHum to 

classify sediments on a riverbed. The adaptability of side scan sonar and the convenience of the 

Humminbird platform allow new uses to be discovered without large start-up costs. 

Future Applications 

The reef comparisons in this study show how the side scan methodology can answer macro-scale 

questions about artificial reefs. However, questions that can be answered using the methodology 

are not limited to artificial reefs or macro-scale analyses. This methodology can be adapted for a 

number of different aquatic environments. A lower frequency or increasing tow-cable length 

would allow sampling in deeper habitats. Conversely, using the methodology in shallower 

habitats, like a lake [104], can be accomplished by using a shorter cable or a hull mounted 

transducer. The adaptability and affordability of side scan sonar will make it an attractive option 

for fisheries managers all over the world. The side scan methodology reported here allows large 

scale comparisons of numerous reef habitats for reef fish abundance, size classes and biomass in 

a variety of sea states and visibility levels. 
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APPENDIX A
 
 

MODIFICATIONS AND DETAILED SIDE SCAN SONAR METHODOLOGY 
 
 
Humminbird Settings 

The “transducer” selection was set to the hi-def sidescan. “Side Imaging Frequency” was 

set to 455 kHz. Only this side imaging frequency was used to maximize resolution of fishes 

backscatter, while taking into account transmission loss due to attenuation. The side scan “Range” 

was set to 30 m past the known maximum depth of each site to accurately sample the whole 

water volume. “SI Sensitivity” was set at 15 and “Chart Speed” at 10. “Down Imaging” was set 

to 200 kHz. “Water Type” was set to Salt. All other defaults were followed in the unit. 

 

Modifications 

The following modifications to the standard Humminbird and towfish were made: (1) the 

transducer cable was extended using a 60 m cat-7 data cable (part # Hyperline-SSTP4-C7 

Certicable, Farmington, NY, USA) to bear the load of the towfish as it is pulled through the 

water; (2) a connector (part # MCIL8, SubConn Inc., MacArtney Underwater Technology Group, 

Esbjerg, Denmark) was added between the towfish and the cable extension to ease the storage of 

both the cable and the towfish; (3) each of the connections were wrapped in aluminum mylar 

tape (Marine Tech Wire and Cable Inc., York, PA, USA) to prevent interference between wires; 

(4) the head unit’s power cable was adapted to fit a small 12v battery with an inline fuse, to adapt 



	

 52 

to a wide range of vessels on which this set up can be used; (5) a longer cable was fitted for the 

units GPS transmitter; (6) to solidify the headunit-transducer connection a Lowrance™ 

transducer extension cable (part # XT-10BLK, Lowrance Electronics, Tulsa, OK, USA) was 

used to connect the circuit board inside the head unit to the transducer; (7) the towfish was hot-

dip galvanized to protect the metal from the marine environment. 

As the Humminbird head unit ages, the connectors on the back panel become fatigued 

and cease to make reliable connections.  Occasionally the power cable would become 

unconnected and the devise would shut off, or the GPS cable would become unplugged and all 

sonar data collected was unusable.  For these reasons, the connectors on the back panel were 

replaced with higher quality screw link connectors.  A Lowrance™ transducer extension cable 

(part# XT-10BLK, Lowrance Electronics, Tulsa, OK, USA) was used for the transducer 

connection and two 4-pin connectors (part# 43-00092, 43-00100 Conec Corp., Garner, NC, 

USA) were used for the power and GPS connections. 

 

Sampling Notes 

When collecting data, shortening the towfish cable length pulled the towfish up into the 

water column enough so that bubbles entrained from the vessel propellers were visible in the 

scans. This is a source of interference that was corrected by slowing the towing speed of the 

vessel or lengthening the towfish cable. Electrical interference was induced when pumps 

drawing high currents were activated. This was mitigated by connecting the sonar directly to the 

boat's 12v power supply and a small 12v UPC battery as a buffer to prevent surges. 
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Python Method 

To run the adapted PyHum code (Appendix B) one must section the original recording in 

HumViewer (v.86) using the Utilities>Create Sub Recording tool. All *.dat and associated 

folders to be analyzed must be able to be located in the same file directory. The user has to put 

the file directory and shortcut name in the associated “filepathWin.txt” or “filepathMac.txt” 

depending on the operating system. The program will also prompt users to input a crop depth 

into the terminal to isolate the water column in the images. 

Preliminary analysis of raw sonar scans revealed significant amounts of attenuation as 

fishes distance from the transducer increased. To get accurate biomass estimates, the PyHum 

image correction module was employed. The module scales scan data into dB W (Watts) where 

it uses a cosine-range correction to find the incident angle of the pings. The incident angle 

coupled with the height above the seabed were used to calculate the ping intensities scaled to 

distance away from the transducer. 

 

SonarTRX Method 

Side scan sonar recordings can also be processed using SonarTRX (v.15.1, Leraand 

Engineering Inc., Honolulu, HI, USA) for a license fee. The original recording was processed in 

SonarTRX to determine average depth and distance of the recording.  Additionally, each 

recording was sectioned using the clip feature in the “View and Edit” tab.  Clips were made so 

that the structure or point being sampled was centered in the middle of the clip.  The clips were 

started after a boat turn was completed and before the next turn was started.  Creating clips 

allows you to process all of the images from the original recording at once. 
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The manual abundance count images were further processed under the Create Mosaic tab 

where master images were created without slant range correcting (SRC) the data, the highest 

resolution, color scheme “Spectrum HV-2D”, “Auto” image correction, Force heading “90”, and 

the range was cropped on all channels to a meter more than the average depth (e.g. Depth=30, 

cropped at “31”). These settings created a master image containing all the tiles from the both 

sonar sides.  The master image (.tiff) is then opened in Photoshop (CS6 v.13.0.1, Adobe Inc.) 

where backscatters on the image are counted using the counting tool (under the eyedropper tool). 

For the automated particle count, the settings were slightly different in SonarTRX.  

Under the Create Mosaic tab where master images were created without SRC, the highest 

resolution, color scheme “Grey values”, “None” image correction, Force heading “90”, and the 

range was cropped on all channels to a meter more than the average depth (e.g. Depth=30, 

cropped at “31”). Grayscale master images were then imported into Photoshop where any 

interference, reef structure and the bottom was removed using the eraser tool. This same image 

will be used in the biomass methodology in the image J processing section.  

 

Image J Processing 

Images were calibrated, counted and had intensities recorded in ImageJ.  Macros were 

written to streamline and loop processing (Appendix C).  Images were first set to 8-bit grey scale 

using Images > Type > 8-bit. Then calibrated using Equation 8 in Analyze>Calibrate where a 

straight line and grey scale need to be selected. Using the determined calibration equation, the x 

and y data can be populated with values that lie on the calibration line. Calibration equations will 

have to be determined for each devise and frequency used using the solid sphere methodology 

detailed above. A threshold was set using Image >Adjust >Threshold Settings>Set (e.g., Lower: -
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55 (dB); Upper: -10 (dB)), then particles were counted using Analyze>Analyze Particles (e.g. 

Size: “60-Infinity”, Circularity: 0.15-1) (Table 4). 

 
Table 4. Parameters referenced in Image J counting model.  See text for details. 

Structure 

Lower 

Threshold 

Pixel Size 

Selection 

Circularity Lower 

Limit 

Sonar TRX (Ship) -60 60 0.10 

Sonar TRX (Rig) -55 70 0.10 

Sonar TRX (Low Relief) -51 70 0.15 

PyHum -60 20 0.05 

 

To retrieve individual scatterer TS (i.e. fish size classification) the results from each 

image analysis must be saved.  The macro saves this automatically, but to do it manually, 

process the image like normal.  When the “results” dialog opens, find File> Save As and make 

sure to change the file extenton to the desired output (i.e. *.xls, *.csv, etc.).  From the spredsheet 

use the Love equation to transform the TS to fish length. 
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APPENDIX B
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APPENDIX B
 
 

PYHUM CODE 
 
 
Filename: “filepathWin.txt” 

 It is important that the nickname is in all caps and all of the file paths line up. 

Filename: “filepathMac.txt” 

 Mac users can use this file path dictionary.  Insert your own filepath and nickname for the 

folder that your .dat files occupy.  

For instructions on installing PyHum visit https://github.com/dbuscombe-usgs/PyHum.  

It is nessesary to install all suggested libraries along with the PyHum module.  After install, 

running the following python code, in terminal, will process Humminbird data exactly as 

processed in this study.  It is important to keep the “filepathWin” or “filepathMac” in the same 

folder as the following code.  You can find this code on 

https://github.com/MBollinger89/PyHumAdaptation.   

NICKNAME File path 

BONSAI   C:\\Users\\Student\\Documents\\Mike\\Side_Scan_Data\\Reef_Comparison\\Bonsai 

ABUNDANCE  C:\\Users\\Student\\Documents\\Mike\\Side_Scan_Data\\Abundance 

FISHING  C:\\Users\\Student\\Documents\\Mike\\Side_Scan_Data\\Fishing_Experiment 

NICKNAME       File path 

BONSAI             C:\\Users\\Student\\Documents\\Mike\\Side_Scan_Data\\Reef_Comparison\\Bonsai 

DAILY                C:\\Users\\Student\\Documents\\Mike\\Side_Scan_Data\\Reef_Comparison\\Daily_Comparison 

ABUNDANCE   C:\\Users\\Student\\Documents\\Mike\\Side_Scan_Data\\Abundance 
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#!/usr/bin/python 
import PyHum 
 
import numpy as np 
 
import matplotlib.pyplot as plt 
 
import os 
 
from scipy.io import loadmat 
 
import sys 
 
import sonar_file_path as sfp 
import platform 
 
#================================================= 
# Read sonar data. Do it first 
def read_sondata(hmf,sonDir,c1,f1,model1,chunk1): 
    PyHum.read(hmf,sonDir,c=c1,f=f1,model=model1,chunk=chunk1) 
 
 
#================================================= 
# correct scans 
def correct(humfiles,sonpath,cww): 
    PyHum.correct(humfiles,sonpath,correct_withwater=cww) 
 
     
#================================================= 
# Define a function to put chunks together and crop by depth  
def custom_save(figdirec,root): 
    # Save the figure 
    
plt.savefig(os.path.normpath(os.path.join(figdirec,root)),bbox_inches='tig
ht',dpi=800) 
 
#================================================= 
 
 
def process(humfile,sonpath,depth): 
    # Process the chunks and crop 
 
    # if son path name supplied has no separator at end, put one on 
    maxy = depth 
    print 'Crop size '+str(maxy)+' meters' 
    if sonpath[-1]!=os.sep: 
        sonpath = sonpath + os.sep 
 
 
    base = humfile.split('.DAT') # get base of file name for output 
 
    base = base[0].split(os.sep)[-1] 
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APPENDIX C
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APPENDIX C
 
 

IMAGEJ MACRO 
 
 
The script will process all images in file directory. 

Substitute user defined calibration .txt files for path in line 4.   

 

dir = getDirectory("image"); 
list = getFileList(dir); 
for(i=0; i<list.length; i++) { 
run("8-bit"); 
run("Calibrate...", 
"open=[C:\\Users\\Student\\Documents\\Mike\\Side_Scan_Data\\Calibration\\Corrected 
Calibration\\CorrectedCalibration.txt] function=[Straight Line] unit=[Gray Value] 
text1=[187.915 174.4975 161.08 147.6625 134.245 120.8275 107.41 93.9925 80.575 67.1575 
53.74 40.3225 26.905 13.4875 0.07 ] text2=[-10.0 -15.0 -20.0 -25.0 -30.0 -35.0 -40.0 -45.0 -
50.0 -55.0 -60.0 -65.0 -70.0 -75.0 -80.0 ] global"); 
run("Set Scale...", "distance=0 known=0 pixel=1 unit=pixel global"); 
run("Threshold..."); 
setThreshold(-55, -10); 
run("Analyze Particles...", "size=50-Infinity pixel circularity=0.1-1.00 show=Nothing display 
clear summarize"); 
roiManager("Show All with labels"); 
roiManager("Show All"); 
run("Summarize"); 
name = getTitle; 
index = lastIndexOf(name, "."); 
if (index!=-1) name = substring(name, 0, index); 
name = name + ".xls"; 
saveAs("Results", dir+name); 
run("Open Next");} 
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Michael A. Bollinger was born in York, PA and graduated from Dallastown Area High 

School where he kindled an interest in marine science. His true love for the ocean was instilled 

by his grandfather, uncle and father on fishing trips in the back bays of Ocean City, MD.  His 

interests led him to study biology and marine science at Penn State University. He quickly 

became involved in Club Ultimate Frisbee, the Marine Science Society and undergraduate 
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many diving and research experiences all over the world including: The United Kingdom, the 
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to Texas. 

 As a graduate student at the University of Texas Rio Grande Valley, Mike was able to 

explore the Gulf of Mexico and the field of bioacoustics. At UTRGV he served in several 

capacities including: mastering the art of soldering and splicing cables together; conducting 

ongoing diving and fishing surveys of the artificial reefs; helping to maintain research vessels 

and departmental aquaria; founding the Brownsville Ultimate Frisbee movement; and planning 

the first two years of the Rio Grande Science and Art Festival. In his spare time, Mike enjoyed 

long walks on the beach, painting marine life and of course, playing Ultimate Frisbee. 

 In the future, he hopes to put these acoustic, diving and aquaria skills to use to better 

manage fish populations. As a final note, remember “many men go fishing all their lives without 

knowing it is not fish they are after” ~Henry David Thoreau. 
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